6


МИНИСТЕРСТВО ОБРАЗОВАНИЯ НИЖЕГОРОДСКОЙ ОБЛАСТИ
Государственное бюджетное профессиональное образовательное учреждение
«ПЕРЕВОЗСКИЙ СТРОИТЕЛЬНЫЙ КОЛЛЕДЖ»





Методические указания
 для выполнения практической работы
по дисциплине
«Информационные технологии в
профессиональной деятельности»


Для обучающихся специальности 
08.02.01 Строительство и эксплуатация зданий и сооружений





Составитель Плотников Алексей Викторович


г. Перевоз
2015

Составитель: Плотников А. В..
УДК 33
ББК 65

Методические указания  для выполнению практической работы по дисциплине «Информационные технологии в профессиональной деятельности»/ Перевозский строит. колледж; Сост.: А.В. Плотников. – Перевоз, 2015. – 44с


Данные методические указания составлены в помощь преподавателям и обучающимся. Методическая разработка содержит указания по оформлению и выполнению практических работ по дисциплине. Предназначены для студентов 3 курса, специальности 08.02.01 Строительство и эксплуатация зданий и сооружений.


Рецензенты: 
Алтынбаева И.Г. – зав. кафедрой, преподаватель  ГБПОУ «Перевозский строительный колледж».
Старова Н.Н.  преподаватель  ГБПОУ «Перевозский строительный колледж».

                                                                                  © Перевозский строительный
                                                                                           колледж, 2015


	Рассмотрено на заседании кафедры
строительного направления
Протокол № ____ «____» _______ 20____ г.
Заведующий кафедрой
______________________ Алтынбаева И.Г..
	Утверждено на заседании 
Методического совета
Протокол № ____ «____» _______ 20____ г.
Начальник ОИО и СО
_________________ Курикова Г.В.






17

44

СОДЕРЖАНИЕ
Содержание методических указаний………………………………………4
Методические указания для практической графической работы……….6
Основные принципы построения чертежа…………………………………14
Команды редактирования…………………………………………………...24
Выполнение чертежа здания………………………………………………..34
Информационное обеспечение……………………………………………...44




































Содержание методических указаний для выполнения практической работы

Введение
Методические указания разработаны в соответствии с программой курса, изучаемой на специальности строительного направления, с целью формированию профессиональных (ПК) и общих компетенций (ОК), практического усвоения материала по применению информационных технологий в будущей профессиональной деятельности. Выполнение практических работ с применение различных программ способствует усвоению, закреплению и углублению знаний и приобретению навыков в области безрасчетного проектирования конструктивных элементов зданий и сооружений.
В методических указаниях приведена методика и порядок использования всевозможных функций графического комплекса AutoCAD; правила выполнения графической части задания. 
Данное методическое пособие поможет обучающимся в работе над первым курсовым проектом, в приобретении навыков выполнения и оформления архитектурно-строительных чертежей, составлении и оформлении пояснительной записки. Эти навыки пригодятся обучающимся при выполнении курсовых проектов по другим дисциплинам, а также дипломного проекта. 
Методическое пособие предназначено для очной и заочной форм обучения.

Цель и задачи освоения дисциплины

В результате освоения дисциплины обучающийся должен уметь:
· применять программное обеспечение, компьютерные и телекоммуникационные средства в профессиональной деятельности;
· отображать информацию с помощью принтеров, плоттеров и средств мультимедиа;
· устанавливать пакеты прикладных программ.

В результате освоения дисциплины обучающийся должен знать:
· состав, функции и возможности использования информационных и телекоммуникационных технологий в профессиональной деятельности;
· основные этапы решения задач с помощью электронно-вычислительных машин;
· перечень периферийных устройств, необходимых для реализации автоматизированного рабочего места на базе персонального компьютера;
· технологию поиска информации;
· технологию освоения пакетов прикладных программ.

Компетенции обучающегося, формируемые в результате освоения дисциплины

Процесс изучения дисциплины направлен на формирование следующих компетенций в соответствии с программой ФГОС СПО по специальности 08.02.01 Строительство и эксплуатация зданий и сооружений:
ПК 1.1 Подбирать строительные конструкции и разрабатывать несложные узлы и детали конструктивных элементов зданий
ПК 1.2 Разрабатывать архитектурно-строительные чертежи с использованием информационных технологий
ПК 1.3 Выполнять несложные расчеты и конструирование строительных конструкций
ПК 1.4 Участвовать в разработке проекта производства работ с применением информационных технологий
ПК 2.3 Проводить оперативный учет объемов выполняемых работ и расхода материальных ресурсов
ПК 2.4 Осуществлять мероприятия по контролю качества выполняемых работ
ПК 3.1 Осуществлять оперативное планирование деятельности структурных подразделений при проведении строительно-монтажных работ, текущего содержания и реконструкции строительных объектов
ПК 3.2 Обеспечивать работу структурных подразделений при выполнении производственных задач
ПК 3.3 Обеспечивать соблюдения требований охраны труда, безопасности жизнедеятельности и защиту окружающей среды при выполнении строительно-монтажных и ремонтных работ и работ по реконструкции строительных объектов
ПК 4.1. Принимать участие в диагностике технического состояния конструктивных элементов эксплуатируемых зданий.
ОК 1 Понимать сущность и социальную значимость своей будущей профессии, проявлять к ней устойчивый интерес
ОК 2 Организовывать собственную деятельность, выбирать типовые методы и способы выполнения профессиональных задач, оценивать их эффективность и качество
ОК 3 Принимать решения в стандартных и нестандартных ситуациях и нести за них ответственность
ОК 4 Осуществлять поиск и использование информации, необходимой для эффективного выполнения профессиональных задач, профессионального и личностного развития
ОК 5 Использовать информационно-коммуникационные технологии в профессиональной деятельности
ОК 6 Работать в коллективе и в команде, эффективно общаться с коллегами, руководством, потребителями
ОК 7 Брать на себя ответственность за работу членов команды (подчиненных), за результат выполнения заданий
ОК 8 Самостоятельно определять задачи профессионального и личностного развития, заниматься самообразованием, осознанно планировать повышение квалификации
ОК 9 Ориентироваться в условиях частой смены технологий в профессиональной деятельности



















Методические указания для практической графической работы

На практических занятиях по дисциплине «Информационные технологии в профессиональной деятельности», изучается пакет прикладных программ AutoCAD фирмы Autodesk. Система AutoCAD применяется для автоматизации выполнения проектно-конструкторской документации в областях строительства, архитектуры.
Система AutoCAD позволяет выполнять конструкторскую документацию в соответствии с ГОСТами, ЕСКД, как по качеству исполнения документов, так и по соблюдению требований стандартов, в том числе международных.
На практических занятиях дисциплины выполняются следующие работы:
1. Знакомство со средой AutoCAD, её основными функциями. Создать рабочий чертеж модели детали, содержащий три основных вида модели детали, необходимые разрезы, размеры, оформленный в соответствии с требованиями стандартов ЕСКД.
2. Рабочий чертеж детали, содержащий элементы сопряжений, оформленный в соответствии с требованиями стандартов ЕСКД.
3. Трехмерные твердотельные модели деталей.
4. Чертежи деталей на основе трехмерных твердотельных моделей.
Целью работы является: знакомство с операционной средой AutoCAD; демонстрация возможностей AutoCAD на основе различных файлов чертежей, выполненных в AutoCAD.

Интерфейс программы AUTOCAD
Для запуска программы AutoCAD необходимо:
· на рабочем столе найти ярлык программы AutoCAD и дважды щелкнуть на нем левой кнопкой мыши;
· в меню Пуск выбрать команду Пуск > Программы > Autodesk > AutoCAD 2014 > AutoCAD 2014.
Окно программы AutoCAD содержит следующие элементы:
· Строка меню;
· Панели инструментов (Лента с вкладками панелей инструментов);
· Область чертежа;
· Окно командной строки;
Строка состояния (рис. 1).
[image: ]
Внешний вид окна AutoCAD меняется в зависимости от выбранного рабочего пространства: 2D рисование и аннотации, 3D моделирование, Классический AutoCAD. Переключатель рабочих пространств находится в строке состояния. Рабочие пространства 2D рисование и аннотации, 3D моделирование содержат ленту с вкладками, на которых располагаются панели инструментов. Классический AutoCAD поддерживает интерфейс предыдущих версий AutoCAD и позволяет вызывать на экран требуемые панели инструментов.
Раскрывающиеся меню
Строка меню в верхней части окна AutoCAD (см. рис. 1) содержит раскрывающиеся меню для выбора команд. Команды в меню сгруппированы по функциональному признаку.
При выборе команды в меню (на панели инструментов) в строке состояния (на экране) выводится дополнительная информация, содержащая назначение и имя команды.
Панели инструментов
На панелях инструментов расположены командные кнопки (инструменты или команды) и раскрывающиеся панели, которые выводят список дополнительных инструментов. Раскрывающиеся панели отмечены маленькой стрелкой в правом нижнем углу. При помещении курсора мыши на значок инструмента, выводится имя этого инструмента, отражающее выполняемое действие.
Если панель инструментов отсутствует на экране, ее можно вызвать, щелкнув правой кнопкой мыши на любом инструменте панели, или выбрав в меню Вид > Панели (View > Toolbars).
Задание 1.
В рабочем пространстве Классический AutoCAD вывести на экран следующие панели инструментов: Стандартная (Standard), Свойства (Properties), Рисование (Draw), Редактирование (Modify), Слои (Layers), Стили (Styles), щелкнув правой кнопкой мыши на любом инструменте или выбрав команду Вид > Панели инструментов (View > Toolbars), и разместить их в окне AutoCAD. Другие панели инструментов необходимо убрать с экрана.
Окно командной строки
В нижней части экрана над строкой состояния находится окно командной строки (см. рис. 1). В нем отображаются подсказки (запросы) для ввода команд и данных. Нижняя строка этого окна показывает текущее сообщение, а верхние - предыдущие команды и действия пользователя или те строки текущей команды, которые не поместились на одну строку. На рис. 1 показано сообщение Команда: (Command:), т.е. AutoCAD ожидает ввод команды.
При недостаточном опыте работы с AutoCAD пользователям необходимо внимательно следить за сообщениями, выводимыми в окне командной строки, поскольку именно так поддерживается связь пользователя с AutoCAD. Просмотр предыдущих сообщений осуществляется полосой прокрутки справа. Кроме того, чтобы просмотреть сообщения, можно увеличить окно командной строки или вывести его на экран, нажав клавишу F2.
Область чертежа
Область чертежа занимает основную часть экрана (см. рис. 1). Все, что пользователь чертит, появляется здесь. По области чертежа перемещается курсор мыши.
В левом нижнем углу области чертежа расположен значок системы координат в виде двух стрелок, показывающий направление осей координат X и Y на чертеже (см. рис. 1). Значок системы координат особенно полезен при работе со сложными двумерными чертежами и трехмерными моделями.
Строка состояния
В нижней части окна AutoCAD выводится строка состояния, которая содержит информацию о чертеже (см. рис. 1). В строке состояния выводятся текущие координаты курсора, кнопки режимов чертежа, переключения рабочих пространств и др., а при перемещении курсора на значок инструмента или пункт меню - назначение и имя команды.
Работа с существующим файлом чертежа
Открытие существующего файла
Для того чтобы открыть файл, выполните следующую последовательность действий:
•	Щелкните мышью на инструменте Открыть (Open) панели Стандартная (Standard) или выберите команду Файл > Открыть (File > Open).
Если текущий рисунок не был сохранен, появится запрос на сохранение изменений. После сохранения рисунка или, если вы отказались от его сохранения, появится диалоговое окно Выбор файла (Select File).
•	Выберите требуемый файл (при этом в правой части окна появляется изображение из этого файла) и щелкните на кнопке Открыть (Open).
При поиске требуемого файла можно использовать раскрывающийся список вверху диалогового окна выбора файла для выбора папки, а также список папок и файлов, отображаемый в центре диалогового окна.

Задание 2.
Для выполнения следующих заданий откройте файл ГP03.dwg, находящийся в папке \AutoCAD 2014\Примеры работ.
Управление видом рисунка
Изменение размеров изображения
[image: ]Для изменения размеров изображения используется команда Показать (Zoom), поддерживающая различные способы управления видом рисунка. Варианты команды Показать (Zoom) расположены в раскрывающейся панели Показать Рамкой (Zoom Window) панели Стандартная (Standard) (рис. 2) и в раскрывающемся меню Вид > Зумирование (View > Zoom).

Задание 3.
Получите на экране полный вид всей области чертежа, выбрав инструмент Показать Все (Zoom All) в раскрывающейся панели Показать Рамкой (Zoom Window) следующим образом:
1. Переместите курсор на кнопку Показать Рамкой (Zoom Window) панели Стандартная (Standard). Нажмите и удерживайте левую кнопку мыши. При этом выводится раскрывающаяся панель (см. рис. 2). Кнопку не отпускайте.
2. Удерживая кнопку мыши нажатой, перемещайте курсор по раскрывающейся панели до кнопки Показать Все (Zoom All) и отпустите кнопку мыши. Раскрывающаяся панель исчезает, кнопка Показать Все (Zoom All) появляется на панели. На экране выводится вся область чертежа.
Кроме того, можно выбрать Вид > Зумирование > Все (View > Zoom > All).
Увеличьте отдельную область чертежа: 
1. Выберите в раскрывающейся панели Показать (Zoom) кнопку Показать Рамкой (Zoom Window) или в меню Вид > Зумирование > Рамка (View > Zoom > Window).
2. Щелкните в точке изображения, которая будет одним из углов увеличиваемой области, и переместите курсор по диагонали, растягивая рамку.
3. Нажмите кнопку мыши. Область, заключенная в рамку, увеличится, заполнив весь экран.
Получите на экране предыдущий вид, щелкните на кнопке Показать Предыдущий (Zoom Previous) панели Стандартная (Standard). На экране вновь появится предыдущий вид, в данном случае - весь чертеж целиком.
То же самое можно получить, выбрав Вид > Зумирование > Предыдущий (View > Zoom > Previous).
Для быстрого увеличения или уменьшения изображения используется кнопка Зумирование в реальном времени (Zoom Realtime) панели Стандартная (Standard).
1. [image: ]Щелкните на кнопке Зумирование в реальном времени (Zoom Realtime). Вместо изображения курсора появится значок увеличительного стекла (рис. 3).
2. Поместите курсор Зумирование (Zoom Realtime) в центр экрана, щелкните кнопкой мышью и, удерживая ее, переместите курсор вверх для увеличения масштаба или вниз — для уменьшения. Когда изображение примет требуемый масштаб, отпустите кнопку мыши.
3. Для выхода из режима выберите любую команду, нажмите клавишу ESC или щелкните правой кнопкой мыши.
4. При щелчке правой кнопкой открывается контекстное меню. В нем можно выбрать другие способы вывода изображения.
Команда Показать Границы (Zoom Extents) масштабирует до размеров экрана все нарисованные на чертеже объекты.
Команда Показать Объект (Zoom Object) масштабирует до размеров экрана выбранные объекты (после выбора объектов необходимо нажать клавишу ENTER или правую кнопку мыши).
Панорамирование изображения
В случае, когда чертеж, не помещается на экране целиком, для просмотра участков изображения, скрытых за границами области экрана, используется команда Панорамирование (Pan). Эта команда изменяет вид чертежа аналогично команде Показать (Zoom), но при этом не влияет на его масштаб: сохраняя установленное увеличение, Панорамирование (Pan) перемещает экран по чертежу.
Задание 4.
Для панорамирования, т.е. сдвига изображения на экране:
1. [image: ]Щелкните мышью на кнопке Панорамирование в реальном времени (Pan Realtime) панели Стандартная (Standard). На экране появится курсор мыши в виде руки (рис. 4).
2. Поместите курсор в центр экрана и, нажав левую кнопку, перемещайте его. Изображение на экране  будет следовать за курсором. Получив требуемую часть изображения, отпустите кнопку мыши.
3.	Для выхода из режима выберите любую команду, нажмите клавишу ESC или щелкните правой кнопкой мыши.
Для панорамирования изображения на экране можно пользоваться полосами прокрутки, как и в других приложения Windows.
При выполнении чертежа удобно пользоваться колесиком мыши: перемещение мыши при нажатом колесике панорамирует изображение с сохранение масштаба, при вращении колесика изображение увеличивается (вращение вперед) или уменьшается (вращение назад) в реальном времени.

Сохранение файла
В процессе работы необходимо периодически сохранять свой файл. Можно записывать его под исходным именем посредством команды Файл > Сохранить (File > Save) или под другим именем с помощью команды Файл > Сохранить как (File > Save As), создав таким образом новый файл.
Вводить расширение .dwg необязательно: при сохранении файла AutoCAD добавляет его автоматически.
AutoCAD автоматически сохраняет работу через каждые 10 минут в файле с именем Auto.acS

Редактирование изображения. Выбор объектов
При редактировании объектов чертежа необходимо выбрать объекты, над которыми будет производиться действие. Выбранные объекты изображаются на экране пунктирными линиями. AutoCAD предлагает два подхода к редактированию: запустить команду и затем выбрать объекты для редактирования и нажать ENTER (правую кнопку мыши) или выбрать объекты, а затем запустить команду.
Не все команды AutoCAD допускают использование предварительного выбора объектов. К таким командам относятся: РАЗОРВИ (BREAK), СОПРЯГИ (FILLET), ФАСКА (CHAMFER).
Указание объекта прицелом курсора
Для указания объекта прицел нужно навести так, чтобы выбираемый объект пересекал прицел, а для широких полилиний прицел должен лежать на границе, а не внутри полилинии.
Выбор с помощью рамки
[image: ]Растянуть рамку с помощью левой кнопки мыши. При этом если диагональ рамки определяется слева направо, то выбираются объекты, полностью попавшие в поле рамки. Если диагональ рамки определяется справа налево, то выбираются объекты не только полностью попавшие в рамку, но и пересеченные ею.
Для отмены выбора объекта необходимо нажать клавишу SHIFT и одновременно щелкнуть на выделенном объекте или растянуть рамку. Для отмены выбора всех объектов нажать клавишу ESC.
Базовая точка
Многие команды редактирования выдают запрос Базовая точка или [Перемещение] (Specify base point or displacement).
Базовую точку можно указать, щелкнув мышью или введя ее координаты с клавиатуры. Редактируемые объекты привязываются к выбранной базовой точке (остаются на фиксированном расстоянии от курсора). От базовой точки отмеряется расстояние и указывается направление перемещения. При перемещении объектов базовая точка совмещается с точкой, указанной для перемещения.
Задание 5.
Для изучения последовательности операций по редактированию чертежа измените чертеж детали из файла ГР03.dwg:
1. Сохраните файл ГР03.dwg под именем Чертеж1.
2. Удалите изометрическое изображение детали и знаки направления осей и штриховки. Выберите требуемые объекты с помощью рамки и, если потребуется, прицела курсора. Нажмите клавишу DELETE на клавиатуре.
3. Перенесите три основных вида модели детали горизонтально вправо на 40 мм. Выберите объекты с помощью рамки. Щелкните на инструменте Переместить (Move) панели Редактирование (Modify). Щелкните в любом месте экрана для задания базовой точки, задайте направление перемещения с помощью курсора мыши. Наберите 40 на клавиатуре и нажмите ENTER.
Построение изображений
Для построения чертежа используются команды рисования, служащие для создания различных графических примитивов: отрезков, окружностей, полилиний, дуг, многоугольников, текста. Любое изображение строится путем создания графических примитивов, которые располагаются друг относительно друга требуемым образом и редактируются с помощью команд AutoCAD.
Последовательность действий по вычерчиванию графических примитивов: щелкнуть на инструменте для запуска команды, ввести данные в соответствии с запросом Командной строки. Дополнительные возможности - опции или варианты выполнения команды перечислены в командной строке в квадратных скобках. Опции доступны во время выполнения команды по нажатию правой кнопки мыши

Задание 6.
Постройте (файл Чертеж1.dwg) окружность радиусом 50 мм.
1. Щелкните на инструменте Круг (Circle) панели Рисование (Draw).
2. Прочитайте запрос в Командной строке. Щелкните левой кнопкой мыши на экране там, где нужно расположить центр окружности.
3. Прочитайте запрос в Командной строке. Щелкните левой кнопкой мыши для задания радиуса окружности (или введите значение радиуса окружности с клавиатуры и нажмите ENTER).
4.	Для задания диаметра окружности или выбора других вариантов построения окружности, после выполнения п. 2, указания центра окружности, нажмите правую кнопку мыши и выберите требуемый пункт контекстного меню. Далее действуйте, отвечая на запросы Командной строки.
Для точного позиционирования объектов (примитивов) используются режимы AutoCAD. Типы и толщина линий задаются с помощью технологии слоев. Объекты строятся с помощь левой кнопки мыши, правой кнопкой вызывается контекстное меню для задания опций и выхода из команды.
Выход из AutoCAD
[image: ]Завершив работу с одним чертежом, можно открыть другой, свернуть окно AutoCAD или выйти из него. Чтобы закрыть файл и выйти из AutoCAD, используется команда Выход (Exit) меню Файл (File) или кнопка со значком « Х » в заголовке окна AutoCAD. 
1. Выберите Файл > Выход (File > Exit). Если текущий чертеж не был сохранен,   выводится   диалоговое окно с запросом на сохранение изменений (рис. 6).
2. Щелкните на одной из кнопок.
Сообщение, показанное на рис. 6, выводится при попытке выхода из чертежа, в который были внесены изменения.

Графические возможности AutoCAD
Для того чтобы познакомится с графическими возможностями AutoCAD, откройте файлы, выполненные в редакторе AutoCAD. Просмотрите примеры графических работ, выполняемых в семестре.
Откройте файл ГP07.dwg, содержащий трехмерную модель детали.
1. Для работы с трехмерной моделью откройте панели Вид (View), Визуальные стили (Visual Style) и Тонирование (Render) щелчком правой кнопки мыши на любом инструменте.
2. Если вид модели не изометрический, а ортогональный, то для просмотра трехмерной модели щелкните на инструменте ЮЗ изометрия (SW Isometric) панели Вид (View) или выберите в меню Вид > ЗМ виды > ЮЗ изометрия (View > 3D Views > SW Isometric).
3. Получите различные варианты тонирования на экране с помощью команд панели Визуальные стили (Visual Style).
4. Получите ортогональные виды: спереди, сверху и слева, пользуясь соответствующими инструментами панели Вид (View).
Откройте файл Facade3D.dwg, содержащий трехмерное изображение здания. Визуализируйте изображение с помощью инструмента Тонирование (Render) соответствующей панели. Рассмотрите параметры команды, задаваемые в диалоговом окне Тонирование (Render), вызываемом данной командой.

Вывод на печать
Вывод чертежа на принтер или плоттер осуществляется с помощью команды Печать (Plot) панели Стандартная (Standard) или меню Файл > Печать (File > Plot).
Выводится диалоговое окно Печать (Plot) (рис. 7).
Параметры печати. Выбор устройства вывода
Раскрывающийся список в группе Принтер/Плоттер (Printer/Plotter) (см. рис. 7) позволяет выбрать нужное устройство, если в системе используется несколько устройств вывода. При выборе устройства надо указать в списке его имя. Для печати в файл формата PDF в этом списке выбирается соответствующая строка.

[image: ]

Подавление скрытых линий
В группе ВЭкраны с раскрашиванием (Shaded viewport options) находится раскрывающийся список Способ вывода (Shade plot), позволяющий управлять выводом на печать трехмерных изображений. Список содержит следующие возможности.
Как на экране (As displayed) печатает изображение так, как оно отображается на экране, с различным уровнем качества.
Каркас (Wireframe) изображение без удаления скрытых линий.
Подавление скрытых линий (Hidden) AutoCAD удаляет скрытые лини при построении изображения.
Тонированные (Rendered) выводит на печать тонированное изображение, используя цвет объектов.

Печатаемая область
Раскрывающийся список группы Область печати (Plot area) позволяет задать часть чертежа, которую нужно вывести на принтер.
Экран (Display). Этот параметр выбирается по умолчанию. Распечатывается информация, представленная на экране.
Лимиты (Limits). Границы выводимой на печать информации определяются исходя из границ чертежа.
Вид (View). Для определения выводимой на печать информации параметр Вид (View) использует ранее сохраненный вид чертежа. Для использования данного параметра сначала необходимо создать вид, затем выбрать Вид (View) и выбрать нужный вид в появившемся в окне списке.
Рамка (Window). Для указания выводимой на принтер области данный параметр позволяет использовать рамку. Все, что находится за пределами рамки, на бумаге вычерчиваться не будет.
Для использования данного параметра нужно выбрать Рамка (Window), а затем щелкнуть на кнопке Рамка< (Window<) для того, чтобы задать рамку на экране.
Управление масштабом чертежа
Группа Масштаб печати (Plot scale) позволяет определить масштаб чертежа или вписать чертеж в заданный формат бумаги (см. рис. 7).
Список Масштаб (Scale) позволяет выбрать стандартный масштаб, например 1:1. Для установки масштаба предусмотрены два поля - mm и ед.чертежа (Units). Масштаб допускается любой, но он должен быть корректным. Если масштаб слишком велик, AutoCAD считает, что рисунок не помещается на листе, но распечатывает его. В этом случае можно получить пустую распечатку.
Флажок Вписать (Scale to Fit) позволяет исключить задание масштаба и установить его автоматически в соответствии с размером листа.
Ориентация изображения
С помощью переключателя группы Ориентация чертежа (Drawing orientation) можно задать горизонтальную Альбомная (Landscape) или вертикальную Книжная (Portrait) ориентацию изображения. Можно перевернуть изображение Перевернуть (Plot upside-down).
Настройка параметров линий на чертеже
В группе Таблица стилей печати (Plot style table) диалогового окна (см. рис. 7) имеется возможность выбрать таблицу стилей печати acad.ctb, создать новую None, распечатать цветное изображение черно-белым - monochrome. ctb или в оттенках серого - Grayscale.ctb. Кнопка справа позволяет редактировать таблицу стилей печати. В этой таблице для цвета на экране ставится в соответствие цвет, вес линии, тип линии и д.р. на распечатке.
Предварительный просмотр вывода на печать
Установив все необходимые для вывода на печать параметры, можно щелкнуть мышью на кнопке Просмотр (Preview) (см. рис. 7). AutoCAD покажет, как будет выглядеть чертеж при заданных параметрах. Кроме того, в режиме предварительного просмотра выводятся предупреждающие сообщения, появляющиеся во время обычного процесса вывода на принтер.
Находясь в окне предварительного просмотра, можно приближать и панорамировать рисунок.
Окно Печать (Plot) показывает размеры листа бумаги, положение чертежа на бумаге.
Предварительный просмотр распечатки чертежа осуществляется с помощью инструмента Предварительный просмотр (Preview) панели Стандартная (Standard) или команды Файл >Предварительный просмотр (File > Plot Preview).
Изображение предварительного просмотра зависит от параметров устройства вывода и установок диалогового окна Печать (Plot) (см. рис. 7). В режиме предварительного просмотра можно использовать средства Зумирование/Панорамирование в реальном времени (Zoom/Pan Realtime).

Выполнение практической работы
1. Выполнить упражнения с 1 по 4.
2. Ознакомиться с примерами графических работ, выполняемых в семестре.
3. Вывести на печать чертеж из файла Чертеж1.dwg, содержащий три основных вида модели детали, разрезы, размеры, рамку, основную и дополнительную надписи чертежа. Перед выводом на печать лишние построения необходимо удалить. При выборе устройства вывода установите pdf файл, чтобы вывести изображение в файл. Обратить внимание на папку размещения файла распечатываемого чертежа. Полученный файл легко просмотреть и распечатать на принтере, без установки программы AutoCAD на компьютере.
Вопросы к защите
1. Каким образом вызывается на экран панель инструментов?
2. Как можно просмотреть информацию в окне командной строки?
3. Изменение размеров изображения. Каким образом можно получить на экране полный вид всей области чертежа, увеличить отдельную область чертежа, получить на экране предыдущий вид, быстро увеличить или уменьшить изображение (в реальном времени)?
4. Панорамирование изображения. Каким образом можно сместить вид чертежа, сохраняя установленное увеличение?
5. Редактирование изображения. Последовательность действий. Базовая точка.
6. Построение изображения. Графические примитивы.
7. Формат команды AutoCAD.
8. Использование контекстного меню во время работы команды AutoCAD.
9. Просмотр трехмерного изображения. Виды. Варианты тонирования.
10. Вывод чертежа на печать. Предварительный просмотр печати.
11. Выбор устройства вывода. Установка устройства вывода.
12. Определение распечатываемой информации. Выбор ориентации чертежа и размера листа бумаги при выводе на печать.
13. Задание масштаба распечатываемого чертежа. 
14. Задание начальной точки при выводе на печать.

Основные принципы построения чертежа

Графические примитивы
В системе AutoCAD используется векторная графика, в соответствии с которой изображение строится из заранее определенных в системе основных геометрических элементов - примитивов. В файле векторного формата хранятся координаты точек, используемые для построения графических примитивов. Например, для отрезка - это координаты начальной и конечной точек; для окружности - координаты центра и радиус; для прямоугольника - координаты его вершин; для трехмерного куба - координаты вершин отдельных граней в пространстве с тремя измерениями: длиной, шириной и высотой.
Система AutoCAD использует следующие примитивы: точки, отрезки, круги, дуги, полилинии (непрерывная последовательность отрезков и дуг), мультилинии (ломаная линия, сегменты которой состоят из нескольких параллельных отрезков), сплайны (гладкая кривая, проходящая через заданный набор точек), тексты, эллипсы, многоугольники, твердые тела и т.д.
Создаваемые примитивы принадлежат текущему слою и получают свойства, заданные для этого слоя. Слои можно рассматривать как набор прозрачных параллельных плоскостей, служащих для логической группировки объектов. Общими свойствами, которыми обладают все примитивы, являются: принадлежность к слою, цвет и тип линий. Отдельные примитивы (текст, блок) имеют специальные свойства, такие как гарнитура, угол наклона, точка вставки и т.д. Использование цвета улучшает восприятие чертежа на экране монитора.
При построении чертежа графические примитивы изменяются - редактируются с помощью команд AutoCAD, с целью получения требуемого изображения.

Ввод команд
Для выполнения любой операции в AutoCAD, например, вычерчивания прямой линии, окружности, перемещения, удаления объектов, изменения настроек рабочей среды, необходимо запустить какую-то команду. Команды в AutoCAD выполняют следующие действия: выводят в командную строку подсказки, требующие ввода с клавиатуры или позиционирования графического курсора, или ввода дополнительных параметров команды (опций); открывают диалоговые окна для задания параметров команды.
Большинство команд AutoCAD имеют несколько опций и для своего выполнения требуют ввода одной из них.
Формат команды следующий:
Команда: имя команды [опции] [данные] <...> 
Command: имя команды [опции] [данные] <...>
· Слово Команда: (Command:) - это приглашение AutoCAD к вводу команды (команда вводиться только после появления этого приглашения).
· Имя команды - это полное название команды, которое вводится в командной строке (допускается ввод псевдоимени команды).
· Опции - дополнительные параметры, позволяющие уточнить действие команды; допустимые опции приводятся в подсказке, выводимой в командной строке, и отделены друг от друга косой чертой (имя опции при вводе можно сокращать до одного символа, выделенного в названии опции заглавной буквой).
· Данные - содержат конкретные значения требуемых командой величин (координаты точек, значение радиуса).
· В угловых скобках <...> указывается параметр, предлагаемый системой по умолчанию.
Команда выполняется только после того, как в диалоговом окне или командной строке будет задана вся необходимая информация; результаты действия команды отображаются в графическом окне AutoCAD, а в командной строке вновь появляется приглашение системы: Команда (Command:).
Повторный ввод команд
Для повторного запуска последней команды достаточно нажать клавишу ENTER или Пробел в ответ на приглашение системы Команда: (Command:) или щелкнуть правой кнопкой мыши в области рисования и в контекстном меню выбрать повтор последней команды. Выбрать для запуска одну из четырех последних выполняемых команд из Контекстного меню можно, щелкнув правой кнопкой мыши в командной строке.
Отказ от выполнения команды
Выполнение команды можно прервать, нажав клавишу ESC. 
Способы задания координат
Для вычерчивания графических примитивов необходимо задавать координаты точек. В редакторе AutoCAD ввод координат осуществляется следующими способами:
· указанием положения точки с использование объектной привязки на основе геометрии существующих объектов;
· указанием положения точки с использование графического курсора;
· заданием положения точки с клавиатуры, путем ввода численных значений координат;
· совместным использованием курсора и клавиатуры.

Задание координат точек с помощью объектной привязки
Объектная привязка (Osnap) позволяет задавать новые точки на чертеже, привязываясь к характерным точкам существующих объектов (таким как конечные точки объектов, пересечение объектов, центр дуги или окружности, середина отрезка, дуги или сегмента полилинии) или относительно них. Режим объектной привязки содержит набор инструментов, позволяющих выполнять точные геометрические построения.
Удобно включить режим постоянного использования объектной привязки, в котором AutoCAD автоматически выбирает ближайшую к курсору точку привязки, из установленных по умолчанию, во время выполнения команды, требующей ввода координат точек. При прохождении графического курсора вблизи характерных точек объекта каждая точка помечается маркером, форма которого соответствует типу характерной точки.
Перед применением этого способа задания координат точек необходимо настроить и включить режим Объектная привязка (Osnap). Настройка осуществляется в диалоговом окне, вызываемом щелчком правой кнопки мыши на слове ПРИВЯЗКА (OSNAP) или соответствующей пиктограмме в строке состояния, и выбором в контекстном меню команды Настройка (Settings). Включение и выключение режима постоянной объектной привязки осуществляется клавишей F3 или щелчком мыши на слове ПРИВЯЗКА (OSNAP) в строке состояния.
Для однократного использования какого-либо инструмента объектной привязки в процессе выполнения команды необходимо щелкнуть на инструменте объектной привязки, например, Center (Центр), затем указать линию окружности (дуги, эллипса), к центру которой автоматически «привяжется» курсор. При помещении курсора на линию окружности в ее центре появляется маркер привязки. После появления маркера привязки нужно щелкнуть левой кнопкой мыши. Для выбора инструмента привязки можно использовать контекстное меню, которое вызывают во время выполнения команды, требующей ввода координат точки, удерживая клавишу SHIFT и нажимая правую кнопку мыши при нахождении курсора в рабочей области окна AutoCAD. Данный способ действует только для указанной точки.
В системе AutoCAD по умолчанию принято, что численные значения координат точек, введенных с клавиатуры, всегда имеют более высокий приоритет, чем координаты точек, полученных с помощью объектных привязок. Приоритет координат точек, полученных с помощью инструмента объектной привязки выше приоритета, установленного для координат точек постоянного режима.

Задание координат точек с помощью графического курсора
Для ввода точки необходимо поместить перекрестие графического курсора в нужное место чертежа и щелкнуть левой кнопкой мыши. Тогда координаты х и у указанной точки воспринимаются, как если бы они были введены с клавиатуры, а координаты z принимает значение текущего уровня.
Точность и легкость задания точек значительно возрастают, если при таком способе задания координат точек включены режимы Орто (Ortho) и Шаг (Snap), а в области чертежа отображена фоновая сетка Grid.
Команды рисования
Команды создания графических объектов находятся в панели инструментов и меню Рисование (Draw). В рабочих пространствах 2D рисование и аннотации, 3D моделирование панель инструментов Рисование (Draw) расположена на ленте.
Команды, приведенные в данном разделе, описываются по следующей схеме: имя команды; выполняемое действие; использование и опции.

Команда Отрезок (Line)
Чертит прямую линию (отрезок) или последовательность прямолинейных сегментов (отрезков) «нулевой ширины», в которой начальной точкой каждого следующего сегмента является конечная точка предыдущего. Используется для построения осевых, центровых линий.
Опции:
Замкнуть (Close) замыкает последовательность линий, проводя линию от текущей точки к начальной.
ENTER в ответ на запрос От точки (From point) позволяет начертить последовательность линий из предварительно начерченных линии, дуги, точки или полилинии. Если последний построенный объект на чертеже - дуга, то линия проводится в направлении касательной из конечной точки дуги.
ОТМени (Undo) в ответ на запрос К точке (To point) удаляет последний линейный сегмент.
Вызвать команду. 
В ответ на команду система выдает первый запрос:
Задайте начальную точку: Specijy first point:
Возможные ответы:
· Ввести координаты точки начала отрезка прямой линии с клавиатуры;
· Указать местоположение точки начала линии на экране монитора с помощью графического курсора.
Последующие запросы системы:
Задайте следующую точку: Specijy next point or [Undo]:
· Ввести координаты конечной точки отрезка прямой линии с клавиатуры.
· Указать местоположение конечной точки линии на экране монитора с помощью графического курсора.
· Ввести символ ОТМ (U), если необходимо отказаться от вычерченного отрезка.
· Нажать ENTER для окончания работы с командой.
· Ввести символ З (C), если необходимо соединить текущую и первую точки ломаной линии - получится замкнутый многоугольник.
Многократное использование опции ОТМенить (Undo) приводит к последовательному стиранию отрезков ломаной линии.
Опцию Замкнуть (Close) можно использовать, если предварительно вычерчены не менее двух сегментов ломаной линии. Выполнение команды с опцией Замкнуть (Close) приводит к завершению ее работы.

Задание 7.
Нарисовать горизонтальный отрезок из произвольной точки заданной длины (45 мм). Включен режим Полярный (Polar) или Орто (Ortho).
Задать начальную точку, например, с помощью графического курсора. Переместить графический курсор в требуемом направлении, а затем напечатать на клавиатуре требуемое расстояние: 45 и нажать клавишу ENTER.
Провести отрезок из конечной точки вычерчиваемого отрезка к конечной точке существующего на чертеже (рис. 8).
Рис. 8 [image: ] 
Провести отрезок из конечной точки вычерчиваемого отрезка к середине существующего на чертеже, перпендикуляр к отрезку, точке пересечения отрезков (рис. 9)
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Рисунок 9.
Таким образом, пользователю не нужно вычислять координаты требуемых точек, например, середины отрезка, по координатам нарисованных объектов. Система автоматически рассчитывает координаты характерных точек объектов, соответствующих параметрам режима объектной привязки.
Команда Плиния (Pline)
Создает объекты, называемые полилиниями и представляющие собой последовательность прямолинейных и дуговых сегментов заданной ширины. Полилиния в отличие от последовательности отрезков обрабатывается как единый объект. Команда может использоваться для построения внешнего контура. Полилиния используется в трехмерном моделировании для создания твердых тел произвольной формы.
Опции:
ДУга (Arc) переводит команду в режим вычерчивания дуг. Этот режим предлагает дополнительные возможности - опции режима ДУга (Arc), которые перечисляются в запросе: Конечная точка дуги или [Угол/ Центр/ Замкнуть/ Направление/ Полуширина/ Линейный/ Радиус/ Вторая/ Отменить/ Ширина]. 
Здесь имеется возможность ввести вторую точку, угол, центр, направление, радиус или конечную точку дуги. При перемещении курсора дуга следует за ним в направлении касательной от предыдущего нарисованного линейного сегмента.
Дуговые сегменты полилинии можно задавать любым из способов, рассмотренных для команды Дуга (Arc) (см. ниже).
Замкнуть (Close) позволяет замкнуть полилинию путем проведения сегмента от текущей точки к начальной.
Полуширина (Halfwidth) создает сужающийся линейный или дуговой сегмент по заданным значениям половины ширины в его начальной и конечной точках.
ДЛина (Length) строит сегмент полилинии заданной длины в том же направлении, что и предыдущий.
ОТМенить (Undo) отменяет последний нарисованный сегмент.
Ширина (Width) создает сужающийся линейный или дуговой сегмент по заданным значениям ширины в его начальной и конечной точках.
Вызвать команду.
В ответ на команду система выдает первый запрос: 
Задайте начальную точку: Specify start point:
Возможные ответы:
· Ввести координаты точки начала полилинии с клавиатуры.
· Указать местоположение точки начала полилинии на экране с помощью графического курсора.
После ввода данных в командной строке появляется сообщение о текущей толщине полилинии, а в следующей строке приводится запрос системы и список опций команды:
Текущая ширина линии 0.0000
Задайте следующую точку или
[ДУга/Полуширина/Длина/ОТМенить/Ширина]: Current line-width is 0.0000
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: 
Задание 8
· Начертить с использованием команды Плиния (Pline) фигуру, представленную на рис. 10, ширину линии установить равной 1 мм.
· Начертить с использованием команды Плиния (Pline) изображение, представленное на рис. 11 (без нанесения размеров).
Рис. 11. Замкнутая полилиния
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Рис. 10. Опции команды Плиния (Pline)
Команда Прямоугольник (Rectangle)
Строит полилинию в виде прямоугольника, прямоугольника с фаской, прямоугольника с сопряженными углами по двум заданным точкам - вершинам противоположных углов или координатам вершины одного из углов прямоугольника и значениям длины и ширины - опция Размеры (Dimensions).
Опции:
Фаска (Chamfer) задает размеры фаски для прямоугольника. Вводятся значения длин первой и второй фаски.
Уровенъ (Elevation) задает уровень (координата z) для прямоугольника.
Сопряжение (Fillet) задает радиус сопряжения углов прямоугольника.
Толщина (Thickness) задает трехмерную высоту для прямоугольника (высота сторон прямоугольника).
Ширина (Width) задает ширину полилинии для прямоугольника.
Заданные значения фаски, уровня, радиуса сопряжения, высоты прямоугольника и ширины полилинии становятся текущими значениями, которые используются при последующих вызовах команды Rectangle (Прямоугольник).

[image: ]Задание 9
Начертить прямоугольник, представленный на рис. 12.
Построить   прямоугольники,   используя различные опции команды.



								        Рис. 12.

Команда Мн-угол (Polygon)
Команда Мн-угол (Polygon) строит правильный многоугольник с числом сторон от 3 до 1024. Полученный многоугольник представляет собой замкнутую полилинию. 
Опции:
Сторона (Edge) задает одну сторону.
Вписанный (Inscribed) строит вписанный многоугольник.
Описанный (Circumscribed) строит описанный многоугольник.
Для вписанного многоугольника при указании радиуса описанной окружности в указанную на экране точку будет помещена одна из вершин многоугольника. Для описанного многоугольника в указанную точку попадет середина стороны многоугольника (рис. 13)
[image: ]
Рис. 13.

Задание 10
Начертить шестиугольник, используя различные опции команды (см. рис. 13), для вписанного шестиугольника радиус описанной окружности равен 90 мм, для описанного - 70 мм.
В ответ на первый запрос вводится число сторон шестиугольника: 6, нажать ENTER. Введите число сторон <4>: Enter number of sides <4>:
Затем указывается центр многоугольника или выбирается опция Сторона (Edge) для построения многоугольника по одной из сторон.
Задайте центр многоугольника или [Сторона]: Specify center of polygon or [Edge]:
Далее выбирается опция Вписанный или Описанный многоугольник по умолчанию <В> ( <1>) - Вписанный.
Введите опцию [Вписанный в окружность/Описанный вокруг окружности] <В>:
Enter an option [Inscribed in circle/Circumscribed about circle] <I>:
Вводится значение радиуса или указывается курсором на экране. Задайте радиус окружности: Specify radius of circle:
Начертить пятиугольник (см. рис. 13).

Команда Круг (Circle)
Позволяет  чертить   окружности   «нулевой   ширины», предусматривая различные варианты их построения (рис. 14)
Опции:
2Т (2Р) строит окружность по двум точкам на диаметре.
ЗТ (ЗР) строит окружность по трем точкам, лежащим на окружности.
ККР (Ttr) строит окружность по двум касательным и радиусу.
Кроме того, можно построить окружность по трем точкам касания Кас, Кас, Кас (Tan, Tan, Tan).
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Рис. 14. Варианты вычерчивания окружности с помощью команды Круг (Circle)


Задание 11.
Начертить окружности, используя все варианты команды Круг (Circle) (см. рис. 14).
Команда Круг (Circle) с опцией ККР (Ttr) используется для построения сопряжения двух окружностей (рис. 15).
Задание 12.
Начертить сопряжения двух окружностей, показанные на рис. 15, пользуясь командой Круг (Circle) с опцией ККР, Касательная касательная Радиус (Ttr, tan tan radius).
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Рис. 15. Варианты сопряжения двух окружностей

На рисунках крестиками показаны точки, выбираемые щелчком левой кнопки мыши при выполнении команды Круг (Circle).

Команда Arc (Дуга)
Позволяет чертить дуги, используя различные варианты построения дуги.
Опции:
Угол (Angle) задает центральный угол. Центр (Center) задает положение центра дуги.
Направление (Direction) задает направление касательной из начальной точки дуги.
Конец (End) вводит конечную точку дуги. Длина хорды (Length) задает длину хорды. Радиус (Radius) задает радиус дуги.
Начальная точка (Startpoint) вводит начальную точку дуги.
Варианты вычерчивания дуги (рис. 16).
1. 3 точки (3 Ротг) - по трем точкам, лежащим на дуге.
2. Начало, центр, конец (Start, Center, End) - по начальной точке, центру и конечной точке. Дуга строится против часовой стрелки.
3. Начало, центр, угол (Start, Center, Angle) - по начальной точке, центру и углу. Обычно дуга строится против часовой стрелки от начальной точки, но, если задан отрицательный угол, дуга строится по часовой стрелке.
4. Начало, центр, длина (Start, Center, Length) - по начальной точке, центру и длине хорды. Дуга строится против часовой стрелки от начальной точки, причем по умолчанию строится меньшая из двух возможных дуг (та, что меньше 180°). Если же вводится отрицательное значение длины хорды, то будет нарисована большая дуга.
5. Начало, конец, угол (Start, End, Angle) - по начальной, конечной точкам и углу. Дуга по умолчанию строится против часовой стрелки от начальной точки. Если значение центрального угла отрицательно, то дуга строится по часовой стрелке.
6. Начало, конец, направление (Start, End, Direction) - по начальной, конечной точкам и направлению (угол наклона касательной из начальной точки).
7. Начало, конец, направление (Start, End, Direction) - по начальной, конечной точкам и направлению (угол наклона касательной из начальной точки).
8. Начало, конец, радиус (Start, End, Radius) - по начальной, конечной точкам и радиусу. AutoCAD всегда строит меньшую дугу против часовой стрелки.
9. Центр, начало, конец (Center, Start, End) - по центру, начальной и конечной точкам.
10. Центр, начало, угол (Center, Start, Angle) - по центру, начальной точке и углу.
11. Центр, начало, длина (Center, Start, Length) - по центру, начальной точке и длине хорды.
12. Продолжить (Continue) - как продолжение предшествующей линии или дуги. Аналогичные действия вызываются, если в ответ на первый запрос нажать клавишу ENTER или пробел. Происходит построение дуги подобно варианту «начало, конец, начальное направление». При этом начальной точкой дуги и ее начальным направлением станут соответственно конечная точка и конечное направление последней созданной дуги или отрезка. Этот способ особенно удобен для построения дуги, касательной к заданному отрезку.
По умолчанию принят способ построения дуги по трем точкам
[image: ]

Рис. 16. Опции команды Дуга (Arc) и варианты вычерчивания дуги

Задание 13.
Начертить все варианты дуг с использованием команды Дуга (Arc) в соответствии с рис. 16.

Вопросы к защите
1. Что такое векторная графика?
2. Отличия растровой и векторной графики.
3. Что такое графические примитивы? Какие графические примитивы используются в системе AutoCAD?
4. Формат команды.
5. Способы задания координат.
6. Задание координат точек с помощью режима объектной привязки. Настройка режима автоматического использования объектной привязки. Инструменты объектной привязки. Установленные приоритеты.
7. Задание координат точек с помощью графического курсора. Точность введенных координат.
8. Задание координат с помощью клавиатуры. Форматы ввода значений координат с клавиатуры.
9. Задание координат точек при совместном использовании графического курсора и клавиатуры. Как начертить угол с помощью этого способа?
10. Выполнение и использование команды Отрезок (Line).
11. Выполнение и использование команды Плиния (Pline).
12. Выполнение    и    использование    команды    Прямоугольник (Rectangle).
13. Выполнение и использование команды Мн-угол (Polygon).
14. Выполнение и использование команды Круг (Circle).
15.  Выполнение и использование команды Дуга (Arc).


Команды редактирования

Редактирование изображения с помощь засечек
При выборе объектов перед вводом команды, на них появляются маленькие квадраты - засечки (ручки, grips). С помощью засечек можно изменять форму объектов или быстро перемещать их.
Расположение засечек соответствует характерным точкам примитивов различных типов. Например, при выборе отрезка появляются засечки в конечных и средней точках. При выборе строки текста засечка появляются в точке вставки (рис. 17).
[image: ]
Рис. 17. Примеры расположения засечек
Для редактирования с помощью засечек выбирается одна засечка. Установите курсор на засечку. При этом курсор автоматически устанавливается точно по центру засечки. Щелкните мышью.
Выбранная засечка закрашивается сплошным красным цветом и используется в качестве базовой точки при выполнении команд режима засечек. Эта засечка называется базовой. Затем выбирается одна из команд режимов засечек: Зеркало (Mirror), Перенести (Move), Повернуть (Rotate), Растянуть (Stretch) или Масштаб (Scale). По умолчанию вначале активизируется команда Растянуть (Stretch). Для выбора остальных команд режима можно воспользоваться контекстным меню, вызываемым при нажатии правой кнопки мыши.
Можно активизировать несколько засечек, чтобы сохранить неизменную геометрию между выбранными засечками, для этого при выборе засечек необходимо нажать и удерживать клавишу SHIFT. После того как клавишу SHIFT отпустили необходимо выбрать из набора активных засечек одну, которая будет рассматриваться системой как базовая.
Чтобы убрать объект из набора выбранных объектов с отображаемыми засечками, необходимо нажать клавишу SHIFT и щелкнуть на этом объекте мышью, чтобы отменить выбор и засечки.
Чтобы убрать засечки, необходимо нажать клавишу ESC.
Задание 14.
Получение зеркальной копии с помощью засечек (рис. 18).
1. Выбрать объекты, для которых нужно получить зеркальную копию.
2. Выбрать базовую засечку, щелкнув на ней левой кнопкой мыши.
3. Щелкнуть правой кнопкой мыши и в контекстном меню выбрать команду Зеркало (Mirror).
4. Включить режим Полярный (Polar) или Орто (Ortho).
Нажать и удерживать клавишу SHIFT и указать вторую точку на оси. Нажать ESC для завершения команды.
[image: ]
Рис. 18 Получение зеркальной копии с помощью засечек.
Если включен режим Орто (Ortho), ось будет горизонтальной или вертикальной.
Кроме команд режима редактирования с помощью засечек существуют стандартные команды редактирования. Все команды редактирования выбираются из панели или меню Редактирование (Modify). В рабочих пространствах 2D рисование и аннотации, 3D моделирование панель инструментов Редактирование (Modify) расположена на ленте.

Команды редактирования
Копирование объектов
Команда Копировать (Сору)
[image: ]Чтобы скопировать объекты, их необходимо выбрать и указать начальную и конечную точки. Эти точки называются базовая точка и вторая точка перемещения, соответственно.
Команда создает неограниченное количество копий. Для завершения работы команды необходимо нажать клавишу ESC или ENTER.
Команда Подобие (Offset)
[image: ]Создает новый объект, подобный выбранному объекту, смещенный на указанное расстояние. 
· Задается величина смещения (вводится значение или указывается с помощью курсора на экране);
· выбирается объект для создания ему подобных;
· указывается сторона смещения;
· выбирается объект для создания ему подобных, указывается сторона смещения. Для выхода из команды необходимо нажать ENTER.
Создается больший или меньший объект в зависимости от указанной стороны смещения. Если указана точка снаружи периметра, создается больший объект. Если внутри - меньший объект. (Рис. 19)
[image: ]
Рис. 19 Получение подобия чертежа.

Задание 15.
Постройте изображение, представленное на рис. 3 а, б, используя команду Подобие (Offset). На рис. 19а, б слева показан исходный объект, который является полилинией.

Команда Зеркало (Mirror)
[image: ]Используется для создания зеркальной копии объектов - симметричных объектов: можно начертить половину объекта, а затем отобразить ее вместо того, чтобы чертить весь объект. Указываются две точки оси отражения (рис. 20). На рис. 20 показан результат с сохранение исходных объектов.
[image: ]
Рис. 20 Создание зеркальной копии объектов.
Задание 16.
Получить зеркальную копию объектов (см. рис. 20).
Команда Массив (Array)
[image: ]Копирование объектов в заданном порядке (создание массива копий объектов). Массив может быть круговым (объекты будут расположены по окружности) или матрицей из столбцов и строк - прямоугольный массив.
Выбрать объекты для получения массива копий. Необходимые параметры команды задаются в диалоговом окне (рис. 21)
Имеется возможность выбрать объекты из диалогового окна, нажав кнопку Выбор объектов (Select objects). При этом диалоговое окно исчезает, позволяя выбрать объекты на экране. После выбора объектов необходимо нажать клавишу ENTER или правую кнопку мыши.



[image: ]
Рис. 21 Параметры команд в диалоговом окне массива.

Прямоугольный массив
Задается количество строк (рядов) и столбцов. На рис. 22 построен прямоугольный массив, содержащий три ряда и четыре столбца.
Указываются расстояния между рядами и столбцами и направление. Заданные расстояния откладываются от самой нижней и самой левой точки объекта.
Для графического указания ячеек массива можно использовать курсор (см. кнопки рис. 21). Ячейка массива - это прямоугольник, определяющий расстояния между строками и столбцами. Существующий объект удобен для применения как образец при определении расстояний.
[image: ]Обычно AutoCAD чертит прямоугольный массив снизу вверх и слева направо, но направление можно изменить, задав отрицательные значения расстояния между столбцами и строками.
Угол поворота позволяет повернуть массив на заданный угол.
							      Рис. 22 Прямоугольный массив.
Задание 17.
Построить изображение, показанное на рис. 22.

Круговой массив
Задается центр массива - указывается на экране с помощью графического курсора или в полях диалогового окна вводятся требуемые значения.
Для кругового массива выбирается способ построения: число элементов и угол заполнения; число элементов и угол между элементами; угол заполнения и угол между элементами.
Количество копий задается с учетом оригинала.
Например, в способе построения по числу элементов и углу заполнения значение 360 градусов сообщает о том, что при копировании объекты должны быть равномерно распределены по всей окружности (рис. 23). Если ввести 180, то будет заполнена только половина окружности.
Флажок Поворачивать элементы массива (Rotate items as copied) означает, что объекты копируются с поворотом вокруг центра окружности. Если сбросить этот флажок, то объекты при копировании сохранят свою горизонтальную ориентацию.
Кнопка Просмотр (Preview) позволяет выполнить предварительный просмотр получаемого массива, который затем можно отредактировать, изменив значения параметров команды в данном диалоговом окне.
[image: ]
Рис. 23 Параметры команд в диалоговом окне массива.

Задание 18.
Построить изображение, показанное на рис. 24, размеры выбрать произвольно
[image: ]
Рис. 24 Круговой массив.
Удаление объектов
Команда Стереть (Erase)
Удаляет выделенные объекты.
Для удаления объектов достаточно выделить их и нажать клавишу DELETE.
[image: ]Отсечение части объекта по заданной границе Команда Обрезать (Trim)
При выполнении этой команды необходимо: 
1. Указать режущую кромку, т.е. выбрать объекты, до которых требуется обрезать редактируемый объект, точка 1 (рис. 25).
2. Запустить команду Обрезать (Trim).
3. Выбрать часть объекта, которую требуется обрезать, щелкнув на ней левой кнопкой мыши, точка 2 на рис. 25.
4. Выбрать объект, который нужно обрезать. AutoCAD повторяет запрос, позволяя включить в набор несколько объектов. Если в момент выбора нажата клавиша SHIFT, объект будет не обрезаться, а удлиняться до ближайшей кромки. Нажать ESC или ENTER для выхода из команды.
Опции:
Проекция (Project) Выбор проекции, которую AutoCAD использует при обрезке объектов.
· Нет Без проецирования. AutoCAD обрезает только те объекты, которые пересекаются режущими кромками в трехмерном пространстве.
· ПСК Проецирование на плоскость XY текущей ПСК. AutoCAD обрезает объекты, не пересекающиеся режущими кромками в трехмерном пространстве, проекция которых на текущую ПСК пересекается режущими кромками.
· [image: ]Вид Проецирование вдоль текущего направления взгляда. AutoCAD обрезает объекты, пересекающиеся режущими кромками при заданном угле зрения.
Кромка (Edge) Определение способа обрезки объекта: до продолжения режущей кромки или только до реального трехмерного пересечения с ней.
· С продолжением (Extend) Объект обрезается до пересечения с удлиненной режущей кромкой.
· Без продолжения (No extend) Объект обрезается, если режущая кромка пересекает его в трехмерном пространстве.

Рис. 25.
Задание 19.
Получить изображение рис. 25, рассмотреть работу опций команды Обрезать (Trim). Удлинить объекты до указанной кромки с помощью этой команды

Разбиение объекта на составные части 
Команда Разорвать (Break)
[image: ]Для того чтобы удалить часть объекта между двумя точками, необходимо указать одну точку объекта (1), выбранный объект выделяется, затем указать вторую точку (2). (Рис. 26)
Для того чтобы разделить объект в точке, ничего не удаляя, (прямую линию на две линии), необходимо указать требуемую точку на объекте, а затем ввести символ @ и нажать ENTER.
[image: ]Инструмент Разорвать в точке {Break at Point) работает аналогично: выбирается объект, затем указывается точка, в которой требуется разорвать объект.
[image: ]
Рис. 26 Команда Разорвать.

Удлинение объектов
Команда Удлинить (Extend)
[image: ]Выполняется аналогично команде Обрезать (Trim):
1. Выбрать граничные кромки, т.е. выбрать объекты, до которых требуется удлинить редактируемый объект. 
2. 3апустить команду Удлинить (Extend). 
3. Выбрать удлиняемый объект.
4. Выбрать удлиняемый объект, или нажать ESC для выхода из команды.
Задание 20.
Удлинить объекты до указанной кромки.



Растяжение объектов
Команда Растянуть (Stretch)
[image: ]Команда Растянуть (Stretch) используется для перемещения вершин (конечных точек) объектов. Выбирают редактируемые объекты и указывают вершины, которые будут перемещаться, с помощью секущей рамки - раскрывается справа налево (рис. 27). Причем, перемещаются только те вершины, которые включены в последнюю секущую рамку.
3атем указывается базовая точка и вторая точка перемещения. Кроме того, после указания базовой точки можно показать направление перемещения вершин с помощью курсора мыши, набрать на клавиатуре расстояние и нажать ENTER (см. рис. 27)
[image: ]
Рис. 27 Команда Растянуть.

Задание 21.
Начертить прямоугольник 120х50 мм. Растянуть построенный прямоугольник вертикально вверх до размеров 120х70 мм.

Масштабирование объектов 
Команда Масштаб (Scale)
[image: ]Пропорциональное изменение размеров объектов в направлениях X, Y и Z.
Выбираются объекты, запускается команда, указывается базовая точка. Масштабирование объектов производится относительно базовой точки; это означает, что ее положение не изменяется. После указания базовой точки перемещение курсора вызывает пропорциональное увеличение или уменьшение размеров выбранных объектов. Кроме того, имеется возможность задать Масштаб - число, на которое будут умножаться все размеры выбранных объектов. Значения масштаба, большие 1, увеличивают объекты. Значения в пределах от 0 до 1 уменьшают объекты.
Опция Опорный отрезок (Reference) позволяет задать масштаб объекта относительно другой заданной длины:
Длина опорного отрезка <1>: Задать длину (можно указать две точки исходного отрезка на экране) или нажать ENTER.
Новая длина:(Specify new length:) Задать новую длину (можно указать две точки результирующего отрезка на экране).
Если новая длина больше, чем длина опорного отрезка, объекты увеличиваются.

Задание 22.
Построить объекты, представленные на рис. 28, а. Используя команду Масштаб (Scale), получить изображения рис. 28 а, б, в.
[image: ]
Рис. 28 Масштабирование.

Расчленение объектов
Команда Расчленить (Explode)
[image: ]Позволяет разделить выделенный объект на компоненты. Таким объектом может быть блок, ассоциативный размер, штриховка, полилиния, область, трехмерное тело.
Поворот объектов
Команда Повернуть (Rotate)
[image: ]Поворот объектов вокруг заданной точки (базовой точки). Выбираются объекты, запускается команда, указывается базовая точка.
Ось, вокруг которой поворачиваются объекты, проходит через указанную базовую точку и параллельна оси Z текущей ПСК.
Задать угол поворота: набрать значение угла на клавиатуре и нажать ENTER или указать навое положение объектов на экране.
Опция Опорный угол (Reference) позволяет выровнять объект по осям X и Y текущей ПСК или по другим элементам рисунка.
Опорный угол <0>:(Specify the reference angle <0>:) Задать исходный угол вводом значения в командной строке или указанием двух точек на экране.
Новый угол:(Specify the new angle:) Задать значение нового угла.  

Задание 23.
Построить объекты, представленные на рис. 29, а. Используя команду Повернуть (Rotate), получить изображения рис. 29, б, в
[image: ]
Рис. 29 Поворот объектов вокруг заданной точки.

Перемещение объектов
Команда Переместить (Move)
[image: ]Выбирают объекты; запускают команду; указывают базовую точку (базовая точка связана с выбранными объектами); указывают точку перемещения (в эту точку будет перемещена базовая точка).

Редактирование полилинии
[image: ]Команда Полред (Pedit)
Меню: Редактирование > Объект > Полилиния Modify > Object > Polyline
Панель Редактирование-2: Редактировать полилинию Modify II: Edit Polyline
После запуска команды необходимо выбрать объекты или ввести Н (Несколько) М (Multiple), чтобы иметь возможность выбора нескольких объектов.
Если выбранный объект является отрезком или дугой, AutoCAD выдает подсказку:
Выбранный объект - не полилиния (Object selected is not a polyline). Сделать его полилинией? <Д>: (Doyou want to turn it into one? <Y>)
Ввести Д (Y) или Н (N) или нажать ENTER.
При ответе Д (Y) такой объект преобразуется в двумерную полилинию, состоящую из одного сегмента.
Опции:
Замкнуть (Close) Создает замыкающий сегмент полилинии, соединяя ее последний сегмент с первым.
Разомкнуть (Open) Удаляет замыкающий сегмент полилинии.
Ширина (Width) Позволяет изменить ширину всех сегментов полилинии на указанное значение.
Добавить (Join) Объединяет несколько объектов в полилинию.
Сгладить (Fit) Построение гладкой кривой, сглаживающей все вершины полилинии, с использованием заданных направлений касательных. Кривая проходит через все вершины полилинии, удовлетворяя при этом значениям касательных, заданных для этих вершин. Может служить для создания волнистой линии на основе ломаной полилинии.
Сплайн (Spline) Создает сплай из полилинии. Сплайн - кривая линия, без угловых точек, плавно огибающая контрольные точки - вершины. В AutoCAD эта кривая носит название полилинии, сглаженной сплайном.
Вершина (Edit vertex) Служит для редактирования вершин полилинии, например, вставки, перемещения, разрыва полилинии между указанными вершинами. Первая вершина полилинии помечается на экране крестиком (X). Если для этой вершины задана касательная, то ее направление указывается стрелкой.
След/Пред (Next/Previous) Служат для перемещения по вершинам полилинии.
Выполнить (Go) Выполняет выбранное действие, например, разрывает полилинию между указанными точками.
Задание 24.
Построить объекты, представленные на рис. 30. С помощь команды Обрезать (Trim) удалить часть линии и окружности. Используя команду Полред (Pedit) с опцией Добавить (Join), получить замкнутую полилинию. После выбора опции Добавить (Join) в контекстном меню, выбрать с помощью курсора добавляемые объекты.
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Рис. 30 Редактирование полилинии.



Изменение свойств объектов
Меню: Редактирование > Свойства
(Modify > Properties) Выбрать объект и щелкнуть правой кнопкой мыши, в контекстном меню выбрать: Свойства (Properties).
Выводит на экран окно свойств объекта. В этом окне можно изменить цвет, слой, тип линий, масштаб типа линий, вес линий, значение трехмерной высоты и другие свойства такие как, радиус для окружности или дуги, высоту текста, параметры размерного стиля. Это окно можно оставить на экране во время работы с файлом чертежа.
Быстрая настройка свойств объектов
[image: ]Меню: Редактирование > Копирование свойств (Modify > Match Properties) Панель Стандартная: Копирование свойств Standard: Match Properties Используется для задания свойств одного объекта другим объектами этого же класса.
· Выбрать объект, свойства которого необходимо распространить на другие объекты этого класса.
· Щелкнуть на инструменте Копироватъ свойства (Match Properties).
· Выбрать объекты, на которые необходимо распространить свойства.
Удобно использовать для быстрого редактирования однострочных текстовых объектов и размеров.
Сопряжение объектов
Команда Fillet (Сопряжение)
Осуществляет плавное сопряжение отрезков, дуг, окружностей или линейных сегментов двухмерной полилинии дугой заданного радиуса (рис. 31).
Опции:
РАДиус (Radius) позволяет задать радиус дуги сопряжения.
ПОЛилиния (Polyline) означает, что операция сопряжения выполняется со всей полилинией (см. рис. 31).
РЕЖим (Trim) устанавливает по умолчанию использование режима обрезки.
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Рис. 31 Сопряжение двух отрезков и линейных сегментов полилинии.
Можно сопрягать две окружности, две дуги, отрезок и окружность, отрезок и дугу, окружность и дугу или два отрезка. При сопряжении дуг и окружностей можно построить более одной дуги сопряжения. AutoCAD выберет сопряжение, конечные точки которого ближе всего к точкам выбора объектов для сопряжения.
Для плавного соединения с дугой сопряжения отрезки и дуги могут обрезаться или удлиняться. Отсекаемая часть является той частью на стороне дуги сопряжения, которая образует точку пересечения с исходным объектом. Такая логика гарантирует плавность сопряжения и обычно совпадает с интуитивным представлением, согласно которому сохраняется та часть, которая указана. Окружности никогда не обрезаются; дуга сопряжения плавно соединяется с окружностью.
Зависимость операций обрезки, удлинения и выбора дуги сопряжения от точек, используемых для выбора отрезка и дуги, показана на рис. 32.
На рис. 32 показаны возможные результаты сопряжения двух окружностей. Местоположение дуги сопряжения зависит от точек, используемых для выбора окружностей.
[image: ]                   [image: ]
Рис. 32 Варианты сопряжения дуг и окружностей.

Выполнение команды Сопряжение (Fillet) для сопряжения двух объектов дугой радиуса 80 мм показано на рис. 33
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Рис. 33. Выполнение команды Сопряжение (Fillet)
Задание 25.
Выполнить все варианты сопряжений, представленных на рис. 31 - 32 с помощью команды Сопряжение (Fillet).

Вопросы к защите
1. Редактирование изображения с помощь засечек.
2. Редактирование изображения. Выбор объектов. Базовая точка.
3. Копирование объектов. Перечислить команды. Порядок работы.
4. Сопряжение объектов. Опции команды.
5. Редактирование полилинии. Опции команды. Использование.
6. Масштабирование объектов. Масштабные коэффициенты.
7. Редактирование свойств объектов. Копирование свойств объектов.
8. Растяжение объектов. Пример работы команды.
9. Создание подобных объектов. Пример использования команды.
10. Перемещение. Копирование объектов.
11. Поворот объектов. Задание угла поворота.
12. Обрезка и удлинение объектов до заданной границы. Опции команд.
13. Растяжение объектов с помощью засечек без искажения формы.
14. Создание единого замкнутого объекта Полилинии.
Выполнение чертежа здания
Настройка рабочей среды
Создание нового файла чертежа
Для создания нового файла чертежа нужно выполнить следующую последовательность действий:
· [image: ]Щелкнуть мышью на инструменте Создать (New) панели Стандартная (Standard) или выбрать команду Файл > Создать (File > New) в раскрывающемся меню. В появившемся диалоговом окне выбора файла шаблона (Select Template) выбрать файл acadiso.dwt и щелкнуть на кнопке Открыть (Open). 
· Выбрать Файл > Сохранить как (File > Save As), чтобы задать новому файлу чертежа имя.
Перед тем как приступить к построению изображения, необходимо настроить рабочую среду. Для этого определяется система единиц измерения, размеры области чертежа и масштаб. В созданном файле по умолчанию размеры области чертежа составляют 420x297 мм, масштаб 1:1, принята десятичная система единиц измерения, где 1 единица равна 1 миллиметру.
Задание единиц измерения
[image: ]При работе с системой можно считать, что графическое окно AutoCAD безразмерно и изображения вычерчиваются в нем в натуральную величину. В системе AutoCAD пользователь выбирает единицы измерения линейных величин, принятые в области его профессиональной деятельности: миллиметры, метры, километры, дюймы и т.д. Определяется формат представления чисел: целый, вещественный, в экспоненциальном виде или в виде дробей. Угловые величины по умолчанию измеряются в десятичных градусах, но можно задать другие единицы измерения углов: градусы, минуты, секунды; радианы; грады; топографических единицы. За начало отсчета угловых величин принято положительное направление оси X координат (слева направо), за положительное изменение углов принято направление против часовой стрелки.
Как правило, при работе используются установленные по умолчанию метрическая система единиц измерения и стиль Десятичные (Decimal), в соответствии с которыми размеры задаются в миллиметрах и десятичных долях миллиметра. Кроме того, необходимо установить точность используемых единиц измерения. (Рис. 34)         Рис. 34 Единицы чертежа
Задание 26.
Создайте новый файл чертежа формата A3. Установите точность единиц измерения - один знак после запятой.
Для задания точности единиц измерения необходимо выполнить команду Формат > Единицы (Format > Units) и в раскрывающемся списке Точность (Precision) диалогового окна Единицы чертежа (Drawing Units) выбрать 0.0 - один знак после запятой (0 - целые).
Настройка размеров области чертежа
Определение размеров области чертежа
Одно из важных преимуществ AutoCAD - возможность полномасштабного черчения (по действительным размерам, в натуральную величину), без ограничений на размер листа бумаги.
При выполнении чертежа по действительным размерам необходимо определить размеры области чертежа в зависимости от заданного масштаба и размера формата чертежа. Для преобразования размера формата чертежа (листа бумаги) в размер полномасштабного чертежа применяются коэффициенты масштабирования. Коэффициенты масштабирования представляют собой значения, на которые нужно умножить размер на итоговой распечатке, чтобы получить эквивалентный полномасштабный размер.
При использовании метрической системы в качестве коэффициентов масштабирования можно применять непосредственно масштаб чертежа, например, масштаб 1:50 будет иметь коэффициент масштабирования 50, масштаб 1:100 - коэффициент масштабирования 100 и т.д.
Коэффициенты масштабирования используются для задания размеров области чертежа, высоты текста, ширины полилиний и нанесения размеров на чертеже.
Например, формат листа бумаги, на котором будет распечатан чертеж в масштабе 1:100, имеет размер 420х297 мм. Для того чтобы определить эквивалентный полномасштабный размер такого чертежа нужно умножить размеры формата листа на 100. Таким образом, для вывода чертежа в масштабе 1:100 на листе бумаги размером 420х297 мм область рисования должна иметь размеры 42000х29700 мм.
Установка размеров области чертежа
Задание 27.
Для задания размеров требуемой области чертежа необходимо:
· Выбрать команду Формат > Лимиты (Format > Drawing Limits).
· В ответ на запрос Указать левый нижний угол или [Вкл/Откл] <0,0>: (Specify lower left corner or [ON/OFF] <0,0>:) нажать ENTER для ввода значения по умолчанию.
Обратите внимание: в системе AutoCAD в угловых скобках, например, <0,0>, задаются значения, принятые по умолчанию. Для их ввода достаточно нажать клавишу ENTER.
•	В ответ на запрос Правый верхний угол <420,297>: (Upper right corner <420,297>:) ввести значения координат правого верхнего угла области чертежа. В данном случае необходимо ввести 42000,29700 для задания эквивалентного полномасштабного размера чертежа масштаба 1:100, выводимого на листе бумаги формата А3, и нажать клавишу ENTER.
Обратите внимание: при задании координат точки X и Y отделяются друг от друга запятой, а целая часть числа от дробной - точкой.
•	Отобразить на экране всю рабочую область, выполнив команду Вид > Показать > Все (View > Zoom > All). Чтобы проверить размеры рабочей области можно переместить курсор в правый верхний угол области чертежа и посмотреть в строке состояния значения координат.
Контроль границ области чертежа
Контроль границ области чертежа - невозможность чертить (вводить координаты) за пределами установленной области чертежа. Для контроля границ области чертежа используются опции ВКЛ/ОТКЛ (ON/OFF) команды Формат > Лимиты (Format > Drawing Limits).
Для того чтобы включить контроль границ, после выбора в меню команды Формат > Лимиты (Format > Drawing Limits) необходимо щелкнуть правой кнопкой мыши в пределах рабочей области и выбрать опцию ВКЛ (ON) или ввести с клавиатуры ВКЛ (ON) и нажать клавишу ENTER. Выключение контроля границ осуществляется аналогично, опция ОТКЛ (OFF) команды Формат > Лимиты (Format > Drawing Limits).
Использование режимов AutoCAD
AutoCAD имеет ряд дополнительных средств рисования, которые называются режимами и используются для точного и быстрого построения изображения. Для управления режимами AutoCAD служит диалоговое окно Режимы рисования (Drafting Settings), вызываемое щелчком правой кнопки мыши на названии режима в строке состояния и выбором в контекстном меню пункта Настройки (Settings) (рис. 35).
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Рис. 35 Режимы рисования.
Шаг (Snap) - режим, при котором графический курсор перемещается только по узлам воображаемой сетки с заданным шагом (F9).
Сетка (Grid) - выводит на экран монитора изображение фоновой вспомогательной сетки с заданным шагом (F7).
Орто (Ortho) - режим, при котором система проводит линии, направленные вдоль осей координат (F8). При включении данного режима курсор будет перемещаться только вертикально или горизонтально.
Полярный (Polar) - режим, при котором система проводит линии под определенными углами, при этом на экране точками отображаются вспомогательные линии, помогающие пользователю создавать новые объекты, точно позиционируя их по углу. Режимы Орто и Полярный должны устанавливаться поочередно, их совместной действие не допускается (F10).
Объектная привязка (Object Snap) - режим, позволяющий пользователю точно позиционировать новые объекты относительно характерных точек существующих объектов (F3).
Отслеживание (Object Snap Tracking) - режим автоматического отслеживания характерных точек объектов, позволяющий пользователю точно позиционировать новые объекты относительно существующих (F11).
Режим Шаг (Snap) применяется для точного ввода расстояний с помощью курсора. Интервал перемещения курсора по осям X и Y задается в диалоговом окне (см. рис. 35) в группе Шаг (Snap).
Режим вывода сетки позволяет видеть границы рисунка и визуально определять расстояния. Сетка выводится только в границах рабочей области (см. рис. 35).
Для совместного использование режимов Сетка (Grid) и Шаг (Snap) интервалы перемещения можно задавать равными интервалам линий сетки, что позволяет видеть каждую точку привязки.
Задание 28.
Для дальнейшей работы необходимо включить режимы Полярный (Polar), Объектная привязка (Object Snap) и Отслеживание (Object Snap Tracking).
Для работы в автоматическом режиме Объектная привязка (Object Snap) включить следующие параметры: Конточка (Endpoint), Середина (Midpoint), Центр (Center), Пересечение (Intersection).
Создание чертежа на основе существующих элементов изображения
Чертеж здания можно выполнить, используя готовые чертежи отдельных элементов и средства AuotCAD по созданию сборок.
При выполнении чертежа необходимо следить за тем, в каком пространстве производится работа: модели или листа. Чертеж здания выполняется в пространстве модели.
Элементы зданий содержатся в следующих файлах папки AutoCAD:
Коробка здания - Коробка. dwg; Цоколь здания - Цоколь. dwg; Крыша здания - Крыша. dwg; Поверхность земли - 3емля.dwg; Окно ОК1 - ОК1. dwg; Окно ОК2 – ОК2. dwg; Окно ОК3 - ОК1.dwg; Дверь - Дверь. dwg; Балкон - Балкон. dwg; Козырек над входной дверью - Козырек. dwg; Подоконник - Подоконник. dwg; Порог – Порог. dwg.
Вставка блока
Повторяющиеся части чертежа или весь чертеж можно сохранить в виде элементов чертежа (блоков), что позволяет использовать их для дублирования. Для облегчения работы создают библиотеку таких элементов. Библиотека элементов чертежа - это файлы чертежей, каждый из которых содержит только описание блока.
Блок - это набор объектов объединенных в единый объект. Можно вставить, масштабировать, повернуть, копировать блок на чертеже. Можно разделить (расчленить) блок на компоненты, отредактировать их и переопределить блок. AutoCAD изменит все текущие и будущие экземпляры этого блока, основываясь на описании блока.
При вставке блока из внешнего файла связь нового блока с внешним файлом теряется, и новый блок со своим индивидуальным именем будет храниться в текущем файле чертежа.
Задание 29.
Вставьте изображение коробки здания из файла Коробка. dwg. папки AutoCAD 2009, примерно в центре рабочей области (рис. 36): выберите в панели Рисование (Draw) инструмент Вставить блок (Insert Block) или в меню Вставка > Блок (Insert > Block). В диалоговом окне Вставка (Insert) выберите блок из внешнего файла чертежа (кнопка Обзор - Browse).
Сбросьте флажок Задание на экране (Specify On-Screen) в группе Точка вставки (Insertion Point) диалогового окна Вставка (Insert).
После вставки изображения из другого файла необходимо воспользоваться командой Показать Все (Zoom All) для просмотра всей области чертежа. Команда Показать Все (Zoom All) выводит область чертежа, установленную в команде Лимиты (Limits), а также все объекты, включенные в чертеж вне этих пределов.
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Рис. 36 Фрагмент фасада здания.
Использование объектной привязки
Элементы чертежа в редакторе AutoCAD можно размещать не произвольно, а в привязке к характерным точкам объектов, таким как центр дуги или окружности, конечные точки объектов, пересечение объектов, середина отрезка, дуги или сегмента полилинии, используя соответствующие инструменты объектной привязки (табл. 1). Объектная привязка позволяет выполнять точные геометрические построения.
Таблица 1
[image: ]

Задание 30.
Вставьте изображение окна из файла OK1.dwg в виде блока, установив флажок Задание на экране (Specify On-Screen) для точки вставки в диалоговом окне Вставка (Insert). Флажок Расчленить (Explode) должен быть сброшен. Базовой точкой данного блока является левый верхний угол рамы окна (см. рис. 36).
Для того чтобы точно расположить окно, используется режим объектной привязки Пересечение (Intersection), AutoCAD автоматически выбирает ближайшую к курсору точку привязки из установленных по умолчанию. Режим объектной привязки должен быть включен и настроены параметры данного режима.
1. При вставке блока ОК1, переместите курсор на одну из линий возле их пересечения (см. рис. 36) - на нем появится значок «X», называемый маркером режима привязки, и ниже имя точки привязки для выбираемой точки.
2. Щелкните мышью, для выбора точки, определяемой маркером привязки.
Вид маркера привязки меняется в зависимости от типа выбираемой точки привязки.
Все инструменты объектной привязки находятся в панели Объектная привязка (Object Snap). Для удобства работы можно вывести на экран эту панель (рис. 37).
[image: ]
Рис. 37 Объектная привязка.
Для задания точки на экране во время выполнения команды на ввод координат точки щелкните мышью на инструменте панели Объектная привязка (Object Snap), переместите курсор и, после появления требуемого маркера привязки, щелкните левой кнопкой мыши.
Кроме того, все параметры объектной привязки доступны в контекстном меню (рис. 38), которое выводится в процессе выполнения команды при одновременном нажатии клавиши SHIFT и правой кнопки мыши.
Задание 31.
Вставьте изображение цоколя здания, используя режим объектной привязки Середина (Snap to Midpoint). Выберите середину нижней стороны коробки здания (см. рис. 36). Базовой точкой данного блока является середина верхней стороны цоколя. Получится изображение, представленное на рис. [image: ]39

[image: ]
Рис. 38 Контекстном меню                  Рис. 39 Режим объектной привязки Середина

Вставьте изображения поверхности земли, окна ОК2, двери, козырька, порожка (на левой половине здания) (рис. 40).
[image: ]
Рис. 40 Фасад

Редактирование изображения
[image: ]При выборе объектов перед вводом команды, на них появляются маленькие квадраты - маркеры (засечки, ручки, grips). С помощью засечек можно изменять форму объектов или быстро перемещать их.
Задание 32.
Скопируйте окно ОК1, как показано на рис. 40. Для этого выберите блок ОК1, щелкнув мышью на любой линии блока. В точке вставки блока появляется засечка.
1. Установите курсор на засечку. При этом курсор автоматически устанавливается точно по центру засечки. Щелкните мышью. Засечка закрашивается сплошным цветом. Такая засечка называется активной и используется в качестве базовой точки.
2. Щелкните правой кнопкой мыши. Откроется контекстное меню функции редактирования засечек (рис. 41).
3. Выберите в списке Копировать (Сору).
4. Скопируйте окно как показано на рис. 40. Для выхода из команды нажмите ESC.
5. Чтобы убрать засечки, нажмите клавишу ESC.                                      Рис. 41
Кроме функции редактирования с помощью засечек существуют стандартные команды редактирования (табл. 2). Все команды редактирования выбираются из панели или меню Редактирование (Modify). Порядок их выполнения рассмотрен выше.
Таблица 2
[image: ]

Задание 33.
Удалите лишние линии внутри двери и порога с помощью команды Обрезать (Trim) (см. рис. 40). При этом необходимо помнить, что блок работает как единый объект, даже если содержит несколько исходных объектов. Отдельные объекты блока могут быть модифицированы только после применения команды Расчленить (Explode) панели Редактирование (Modify). Когда они будут отредактированы, их можно снова объединить в блок.
1. Разбейте на отдельные объекты (расчлените) блоки Коробка здания, Цоколь, Земля, линии которых требуется удалить, а также блоки Дверь и Порог, определяющие режущие кромки, при помощи команды Расчленить (Explode).
2. Запустите команду Обрезать (Trim) и выберите внешний прямоугольник двери, нажмите ENTER, затем щелкните на линиях цоколя и коробки здания, которые нужно удалить. Для выхода нажмите ESC.
Аналогично удалите линии внутри порога.

Вставка внешней ссылки
В файл чертежа AutoCAD можно вставить внешнюю ссылку (External Reference - Xref) на существующий файл чертежа. Внешние ссылки используются для вставки изображения из внешнего файла в текущий файл. Изображение вставленной внешней ссылки редактировать нельзя, но можно использовать привязку к точкам объектов, входящих в файл внешней ссылки.
Как и блок, внешняя ссылка отображается в файле как единый объект, но в отличие от блока внешнюю ссылку расчленить нельзя, но можно превратить в блок.
· Файл внешней ссылки не становится частью базы данных чертежа, а значит, не увеличивает объем файла.
· Все изменения, вносимые в файлы ссылок, автоматически отражаются в файле, содержащем эти внешние ссылки.
· Внешние ссылки удобно использовать при совместной работе над проектом группы разработчиков.
Для вставки внешней ссылки используется инструмент Вставка Внешней ссылки (External Reference) или команда Вставка > Ссылка на DWG (Insert > Xref Manager).

Задание 34.
Внесем изменения в файл Kрыша.dwg. Откройте файл Крыша. Dwg. и сохраните под другим именем, например, Kрыша1.dwg.
В файл фасада здания вставьте изображение крыши из файла Kрыша1.dwg как внешнюю ссылку (рис. 42), обращая внимание на то, где находится базовая точка файла внешней ссылки - середина нижней стороны крыши. Если крыша расположилась неточно, переместите внешнюю ссылку Крыша1, используя ее базовую точку (при выборе внешней ссылки на базовой точке появляется засечка).
Откройте файл внешней ссылки Kрыша1.dwg. Добавьте в файл крыши изображения окон ОК3 в виде внешних ссылок. Тип ссылки установит Вставленная. Сохраните и закройте файл. Соответствующие изменения отражаются в файле чертежа фасада здания (рис.44).
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Рис. 42 Фасад.
Внешние ссылки делятся на два типа - вставленные и наложенные. Наложенные ссылки отображаются только в том файле, в который они вставлены. Вставленные ссылки являются неотъемлемой частью чертежа, в который они вставлены, и будут вставлены вместе с этим чертежом.
Создание блока (элемента чертежа)
Для создания блока в текущем файле чертежа используется диалоговое окно Определение блока (Block Definition) (рис. 43).
Задание 35.
Создайте блок, содержащий отредактированное окно и балкон (см. рис. 42):
1. Вставьте в чертеж фасада здания изображение балкона в виде блока.
2. Расчлените блок ОК1.
3. Скопируйте линию для получения дверной рамы.
4. Создайте блок, содержащий окно и балкон с именем отличным от ОК1 и Балкон, например, Лоджия: выберите инструмент Создать блок (Make Block) панели Рисование (Draw) или Рисование > Блок > Создать (Draw > Block > Make).
5. В диалоговом окне Определение блока (Block Definition) введите имя блока в поле Имя (Name).
6. Нажмите кнопку Выбрать объекты (Select Objects), чтобы с помощью курсора выбрать объекты, включаемые в блок.
7. Укажите: оставить исходные объекта, преобразовать в блок или удалить выбранные объекты.
8. [image: ]Введите значения координат базовой точки (к ней привязываются выбранные объекты) или нажать кнопку Указать (Pick Point), чтобы использовать курсор мыши.
9. Нажать OK.

Объекты можно выбрать до запуска команды Создать блок (Make Block).
Все блоки хранятся в файле чертежа под своими именами и могут быть вызваны из списка блоков в любое время командой Вставить блок (Insert Block).

                                                   Рис. 43 Диалоговое окно Определение блока.
Разблокирование и модификация блока
Для того чтобы модифицировать блок, необходимо разделить его на компоненты, отредактировать их, а затем снова объединить в блок с тем же именем. Такой процесс называется переопределением блока. При переопределении уже вставленного в чертеж блока, в соответствии с проведенным редактированием, будет изменяться каждый экземпляр блока (если он вставлен в чертеж несколько раз).
Задание 36.
Переопределите блок ОК1, так чтобы он содержал окно и подоконник (см. рис. 44):
1. Вставьте в чертеж фасада здания изображение подоконника в виде блока.
2. Расчлените блок ОК1.
3. Создайте блок ОК1 (с тем же именем, той же точкой вставки, но с другими объектами). Изменится каждый экземпляр блока ОК1 на чертеже. Блоки, которые предполагается переопределять, не расчленяем.
[image: ]
Рис. 44 Порядок переопределения блока.

Сохранение блока в виде файла чертежа
При вставке файла чертежа командой Блок (Insert Block) вставляемый чертеж автоматически преобразуется в блок текущего чертежа. Но при переопределении такого блока его изменения не отразятся на используемом для вставки файле. AutoCAD изменит только блок текущего чертежа. Для того чтобы использовать данный блок в других файлах, его необходимо сохранить как файл чертежа на диске.
Задание 37.
Сохраните на диске модифицированный блок ОК1, содержащий изображение окна ОК1 с подоконником.
Для этого выберите Файл > Экспорт (File > Export).
В диалоговом окне задайте имя файла с расширением .dwg. В раскрывающемся списке Тип файла (File of type) должно быть выбрано Блоки (*.dwg) (Block (*.dwg)). Назовите файл OK1uПодоконник.dwg. Нажмите кнопку Сохранить (Save).
В ответ на запрос введите имя блока, который нужно сохранить как файл на диске: ОК1 или нажмите ENTER, чтобы сохранить в файле часть изображения.
Можно сохранить файл блока под тем же именем, что и имя исходного блока, в этом случае в запросе имени блока ставится символ равенства «=» и ENTER, или присвоить ему другое имя.
Дополните свой чертеж фасада здания в соответствии с рис. 45, используя блоки и команды редактирования, приведенные выше.
[image: ]
Рис. 45 Готовый фасад

Работа в пространстве листа
Окно чертежа AutoCAD содержит вкладки, на одной из которых расположено пространство модели «Модель» («Model»), а остальные (их может быть несколько) представляют собой аналоги листов бумаги «Лист» («Layout»). Каждая вкладка «Лист» представляет собой пространство листа.
Так как чертеж фасада здания выполнен в пространстве модели в натуральную величину, то для включения в него рамки, основной и дополнительной надписей необходимо использовать пространство листа.
Пространство листа используется для подготовки чертежа к выводу на печать, так чтобы он содержал вид чертежа в заданном масштабе (или несколько различных видов одного чертежа), рамку и надписи, существующие только в пространстве листа.
Размеры рабочей области пространства листа устанавливаются в соответствии с размерами формата чертежа. По умолчанию рабочая область пространства листа для метрической системы единиц измерения составляет 420x297 мм. В дальнейшем эти параметры можно изменять, выбрав команду Файл > Печать (File > Plot).
Переключение в пространство листа
Щелкнуть на ярлыке вкладки Лист1 или на значке ЛИСТ в строке состояния.
Значок системы координат изменится на треугольник.
При первом обращении к листу на нем создается один видовой экран. Изображение листа с тенью и выполненный штриховыми линиями прямоугольник означают текущий формат чертежа и границы области печати для него.
Создание видовых экранов в пространстве листа Видовые экраны позволяют видеть пространство модели.
В процессе компоновки листа для печати можно создавать видовые экраны, которые рассматриваются как «окна» в пространство модели.
Для создания видовых экранов используется вкладка Вид, расположенная на ленте, инструмент Создать или команда Вид > Видовые экраны > Новые ВЭ (View > Viewports > New Viewports). В диалоговом окне Видовые экраны (Viewports) выбирают количество и расположение видовых экранов.
Получение доступа к видовым экранам
Просмотр и редактирование объектов модели можно выполнять в видовом экране листа. Переход с листа в пространство модели видового экрана осуществляется двойным щелчком мыши внутри видового экрана листа. Текущий видовой экран листа выделяется и в его области появляется перекрестье.
Переход в пространство модели
Выбрать ярлык вкладки Модель (Model) или значок МОДЕЛЬ в строке состояния.
Работа с видовыми экранами в пространстве листа Видовые экраны представляют собой прямоугольники, поэтому можно манипулировать ими с помощью команд редактирования: переместить, удалить видовой экран, изменить размеры с помощью засечек. Щелчок на границе видового экрана выделяет его для редактирования.
В пространстве листа объекты внутри видовых экранов не выделяются, но работает привязка к точкам объектов.
Рамку видового экрана можно сделать невидимой для вывода готового чертежа на печать, выключив или заморозив соответствующий слой.
Масштабирование изображений в пространстве листа
Для задания масштаба изображения внутри видового экрана необходимо перейти в этот видовой экран и выполнить команду Вид > Зумирование > Масштаб (View > Zoom > Scale). В ответ на запрос ввести масштаб чертежа, например 1/100 хп, в качестве масштаба 1:100.
Задание 38.
Чтобы скомпоновать чертеж в пространстве листа, соблюдая точность масштаба необходимо:
1. Перейти в пространство листа.
2. Задать размеры области чертежа формата A3 (Файл > Печать).
3. Перейти в пространство модели видового экрана для доступа к чертежу, дважды щелкнув внутри видового экрана мышью.
4. Установить масштаб изображения 1:100. Расположить изображение фасада с помощью команды Панорамирование в реальном времени (Pan Realtime).
5. Вставить рамку, основную и дополнительную надписи чертежа в виде блока из файла FA3.dwg.

Вопросы к защите
1. Установка стиля и точности используемых единиц измерения.
2. Определение и задание размеров области чертежа.
3. Использование режимов AutoCAD.
4. Вставка блока.
5. Для чего используется и как осуществляется привязка к точкам объектов? Параметры режима объектной привязки. Режим автоматического использования объектной привязки.
6. Редактирование изображения. Команды редактирования. Редактирование с помощью засечек.
7. Блоки. Использование блоков. Создание блока.
8. Переопределение блока. Для чего используется переопределение блока?
9. Сохранение блока в виде файла на диске.
10. Каким образом можно сохранить в разных файлах на диске различные части одного чертежа?
11. Внешние ссылки.
12. Работа в пространстве листа.
13. Использование текста на чертеже.
14.  Создание и использование Текстового стиля.
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